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The Macintosh concept of
the desktop environment, with
files and folders, windows on
top of other windows, and
commands that can be acti-
vated with a simple action of
your wrist and the mouse, is a
powerful analogy to the way
those of us still living in the
precomputer age organize in-
formation. [ have files in draw-
ers and others scattered across
the top of my desk (more on
top than I care to admit). I have
a large collection of pens, pen-
cils, scissors, glues, paper clips,
thumbtacks, cellophane tape,
erasers, rubber bands, and di-
verse notepads cluttering my
desk. I open or close files as
they are needed, take informa-
tion from one file and put it into
another, create new files, and
throw files in the trash.

The overall organization of
the Mac desktop is similar to
my work habits, and it replaces
many of those archaic desk ac-
cessories with more efficient
electronic devices. I feel more
organized and comfortable
with my “electronic” desktop,
especially the way in which I
can control the entire set of op-
erations on the screen with the
mouse and one hand—I lean
back, stretch out my arm, and
edit with ease. No more
hunkering over the keyboard
and typing draft after draft of

not-quite-perfect prose.

And perhaps more impor-
tantly, I feel in command of the
Mac. I don't think I can make
that point strongly enough:
from the moment I switched on
the computer (without the aid
of any instructions) and en-
countered its desktop-like
screen, I knew that [ was in the
presence, not of an enemy ma-
chine to be saddle broken and
conquered, but of an intellec-
tual friend that was going to
take care of certain heretofore
monotonous and unwieldy
tasks.

What I didn't know (and cer-
tainly didn't expect from a
computer) was that the ma-
chine would also stimulate my
creative juices in a way I hadn’t
encountered since I first dis-
covered the opposite sex in the
eighth grade. For me, using the
Mac is like wandering into an
overstocked playpen of the
mind, where each path leads to
another path and each discov-
ery produces more avenues to
explore,

By expanding the skills I
have at hand and the tools I
use, the Mac has expanded my
artistic and intellectual bound-
aries, For instance, I haven't
drawn a picture for years, pri-
marily because I'm so hopeless
an artist. Using MacPaint, how-
ever, I'm rediscovering the lan-
guage of graphic images—I
feel like an electronic Picasso.

What will be the final result
of that new perspective? I don't
know, and the ingrained habit

of thinking in mostly verbal
terms will take time to reverse.
But I'll venture a guess that
within a year I'll be thinking
“visually,” taking into account
the possibilities for graphics in
all my work. That expansion of
my “mental palette” is an excit-
ing prospect. Where it will lead
is the kind of open-ended
question that the Mac asks so
well—and so far refuses to an-
swer with any finite limit.

The Mac may
become the first
truly mass-mar-
ket computer.

The Mac may become the
first truly mass-market com-
puter simply because it doesn'’t
take any special language to
make it work. Whoever you are,
whatever you do, you don't
need to be computer literate to
use it. And yet the simplicity of
the Mac hides a more advanced
computer than has ever before
made it to the personal com-
puter consumer marketplace.

What do the innovations of
the Mac portend for the future?
What are kids going to be like
when they never have to learn
how to use a pencil or an
eraser? Will the Macintosh or
its successors make any lasting

difference, or is the Mac just an-
other mutation of the glorified
electronic beast of the late
twentieth century? These are
questions that will be answered
in the years to come.

However, my intuition tells
me that the Mac will change the
way people think about com-
puters. There are millions of
people like me who don't want
to have to go very far out of
their way to use a compulter.
The Mac will work for us be-
cause at its root, it's more
powerful than most of those
other personal computers (sim-
ple elegance, such as the ease
with which the Mac works, is
always the most difficult thing
to produce), and it reflects the
practical needs of people, not
technically oriented designers.

Let’s see, if I select the
paintbrush from the tool pal-
ette, choose that herringbone
pattern I love so much, and
start to fill in the series of con-
centric circles I just created...
well, I don't know if it will give
Picasso a run for his money, but
itis certainly all mine.

Drag the pointer, open a new
window, and take a look out
into the future. Maybe even
climb through that window.
The Macintosh computer has
arrived.
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B State of the Art

What if a computer could let you work in a famil-
iar environment, similar to the way you work at your
desk? You could put things you wanted to work with on
top of the “desk,” move them around, put documents
into folders or files, and even throw things into the
trash. This description accurately fits the working en-
vironment of Apple’s Macintosh computer. The things
you work with on your desk appear not as words and
numbers in regimented lines, but as graphic objects
located on the Mac screen.

Icons

The Mac desktop, being somewhat smaller than
the average desk it models, doesn’t have room enough
for life-sized objects. At first, objects appear on the
Mac desktop as small pictures called icons. On the
Mag, an icon is a symbol for some concept or object.
For example, when you switch on the Mac and insert a
disk, the screen shows two disk-shaped icons and a
trash can (see Figure 1). As a graphic image, an icon
can remind you about what it represents better than
words alone.

Each icon represents a specific collection of infor-
mation. To avoid ambiguity, icons also have labels. The
disk icon (labeled Write/Paint in Figure 1) represents
the documents and programs stored on the disk in-
serted into the Mac’s disk drive. The dimmed disk icon
labeled Alternate Disk is used for copying files from
one disk to another, and the trash can icon labeled
Trash holds documents and programs waiting to be
purged from the disk.

Pointers and the Mouse

On a real desktop, you move things around. You
may work with one document or file for a while,
switch to another, do some minor calculations, check
the time, and then create a new file. When you finish
working on something, you want to put it away some-
where convenient (such as in a file drawer) so you can
retrieve it later. The Mac lets you do all these things,
but the things you work with exist as graphic images
on the Mac’s electronic desktop.

Since you can't touch things on the Mac desktop,
you need some form of remote control. The mouse is
the key to working on the Mac desktop. Sliding the
mouse on a smooth surface moves a pointer on the
screen. Slide the mouse in any direction—up, down,
sideways, or diagonally—and the on-screen pointer
will move the same distance in the same direction (see
“A Mouse in the Hand” for an in-depth view of the Mac-
intosh mouse).

Moving the mouse moves the pointer, but press-
ing the mouse button makes things happen. For exam-
ple, you can move an icon by placing the pointer over
it, pressing and holding down the mouse button, and
then dragging the icon to a new location. The moment
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Figure 1

The Mac desktop. The Write/Paint disk icon represents the doc-
uments and programs stored on the current disk; the Alter-
nate Disk icon is used for copying files from one disk to
another; and the trash can icon holds discarded documents.
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Figure 2

Dragging an icon. As you hold down the mouse button and
move the pointer, an outline of the selected icon moves across
the screen.
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Figure 3

The File menu. 1o select a command, drag the pointer down
the menu and release the mouse button when the command is
bighlighted.



€ File Edit View Special

Write/Paint

322K in disk

68K available

MacPaint

O

System Folder Empty Folder

(3 3

Drafts Pictures

MacWrite

3

Memo 1/24 Lefter bre

Invite

Write /Paint

&lternate Disk

R

Figure 4
The disk window. The icons represent the documents and pro
grams on the current disk

you press the mouse button, the icon is highlighted. As
the pointer moves, it drags an outline of the icon and
its label along. The outline shows you where the icon
will appear when you release the mouse button (see
Figure 2).

Moving the pointer over an icon and pressing and
releasing the mouse button highlights the icon. This
mouse actuon, called clicking, selects the object but
does nothing except highlight it; you still must specify
an action. In other words, you must give a command.

Menus

On most computer systems, you issue a command
by typing arcane words or symbols on the keyboard
Remembering such commands is difficult enough
from day to day. Go to Hawaii for a week, and you can
plan on a session with the manual when you rerurn

The Mac never forces you to remember command
words or type commands on the keyboard. All Mac
commands are listed in menus, and you choose them
with the mouse. Don't let other menus you have seen
or heard about prejudice you against Mac menus. Most
people say menus are great when you're learning
something, but they slow you down too much when

you know the ropes. Not on the Mac. Most people com-
plain that menus take over the screen, making the in-
formation they're acting on invisible. Not on the Mac.
Most people say even with a menu you still end up typ-
ing in a code number or letter. Not on the Mac. Mac
menus are unobtrusive and fast, and require no typing
The Mac desktop has five primary menus—Apple,
File, Edit, View, and Special—that stretch across the
top of the screen. These menus provide all the com-
mands for organizing and working on the desktop. You
can do everything from opening and closing files to
rearranging icons. The Mac hides its menu commands
under the menu titles. When you move the pointer
over one of the menu titles and press the mouse but-
ton, a list of commands drops down from the menu
bar, temporarily overlaying a small part of the screen.
The Apple menu (represented by the apple sym-
bol) contains a selection of desktop accessories and
controls (see “Desktop Accessories” for a comprehen-
sive look at the Apple menu options). The File menu
lists commands for working with files (see Figure 3),
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The Mac lets you open several windows simul-
taneously. Select another icon, choose the Open com-
mand from the File menu or double-click on the
selected icon, and another window zooms into exis-
tence. Each new window you open overlaps the exist-
ing windows. You may see the edges of existing
windows sticking out underneath the new window, or
the new window may completely hide everything un-
der it. Windows can also cover up the icons on the Mac
desktop (see Figure 6).

The window on top, or frontmost window, is
called the active window. You can bring any window to
the top and make it the active window by putting the
pointer anywhere on it (even an edge that’s sticking
out behind another window) and clicking the mouse
button. You can remove the active window from the
Mac desktop by choosing the Close command from
the File menu. The icon that the window came from
sucks the information back, the window disappears,
and the icon resumes its normal appearance.

You can also move windows around on the Mac
desktop. If you place the pointer over the title bar of a
window, press and hold down the mouse button, and
slide the mouse, a flickering outline of the window is
dragged on the desktop. Let go of the mouse button,
and the window jumps to the new location. When you
move a window by this method, it becomes the top-
most window. However, holding down the 8 key
while you drag a window allows you to move the win-
dow without disturbing its relative position in the pile.
This feature is an example of an “advanced” desktop
management skill that you soon learn after a few work
sessions with the Mac.

Sometimes windows get buried. Unfortunately,
there’s no way to get a side view of the Mac desktop to
see what might be under the frontmost window. But
you can always relocate windows or change their sizes
to uncover the ones underneath.

Window Controls

Think about the appliances you use. They have
pushbuttons, knobs, dials, and other types of controls.
Because the Mac desktop is a general purpose infor-
mation processing appliance, it needs many different
controls. You've seen the way elaborate stereo systems
bristle with knobs, buttons, and dials. Imagine adding
a television, telephone, and pocket calculator to that
collection. Pretty intimidating, but nothing compared
to what the Mac would look like if it had séparate.con-
trols for everything it did.

Most computers handle the control problem by
overworking the keyboard. A few add some so-called
function keys, but you have to be a double-jointed

NASA rocket control specialist to use them effectively.
The Mac displays controls to suit the situation. You use
the mouse to activate buttons and adjust control knobs
displayed on the screen. For example, the disk win-
dow, like most windows, has several controls built in
(see Figure 7). The Mac displays the controls only
when the window is active, however. To close an active
window, you can click the mouse button while the
pointer is over the close box at the left side of the title
bar. Clicking in this displayed box has the same effect
as choosing the Close command from the File menu.
(Savvy Mac users will quickly discover many time-
saving shortcuts.)

The small box displayed in the lower-right corner
of most active windows gives you control over the size
of the window. To make the window narrower, use the
mouse to drag this size box to the left. To make the
window wider, drag the size box to the right. Drag the
size box up and the window gets shorter; drag it down
and the window gets taller. Drag the size box on a di-
agonal to change both height and width simultaneous-
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Figure 7

Window controls en-
able you to change a
window’s size, scroll
vertically or horizon-
tally within it, or close
an active window
using the mouse.

Macworld 23

- vertical

scroll bar






Application Programs

The commands available from the menu bar and
the controls displayed on the screen vary depending
on the program you use. Every program has an icon,
and opening that icon starts the program. Starting a
program opens a window in which you can display a
document of your choice. You can create a new docu-
ment or call up an existing document from the disk.
The program also displays its own menu bar and con-
trols that you can use to inspect and change the
document.

Generally speaking, you can also start a program

The Universal Interface

Although the specific commands and controls are
different from one program to the next, all Mac pro-
grams adhere to certain conventions, including the
use of icons, windows, menus, and the mouse. Once
you discover a way to do something in one program,
you can apply the same principles in other Mac pro-
grams (see “The Mac Way” for more information about
the Macintosh user interface). For example, the
method for moving information from one part of a
document to another is uniform, no matter what kind
of information is involved. That procedure, called cut

by opening a document that you created with it. You
can start the MacWrite word processing program, for
example, by opening a letter you wrote using it. You do
this by double-clicking on the icon representing that
document.

On the Mac, however, you can run only one pro-
gram at a time; you can't open a MacWrite window at
the same time you have a MacPaint window open. Ap-
ple had to leave something for the Lisa to do better.
(You can, however, open and use a desk accessory pro-
gram while you are using another program, and you
can place MacPaint drawings into MacWrite docu-
ments as explained below.) Sorl

and paste, is done entirely with the mouse and the
Edit menu (see Figure 11). The steps are as follows:

1. Select the information to be moved.

2. Choose the Cut command from the Edit menu.

3. Select the insertion point.

4. Choose the Paste command from the Edit
menu.
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The Edit menu. The

Cut and Paste com-
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move text or graphics
Jfromonepartofa
Figure 10 document to anotber.
An alert box warns
of a potentially dan-
gerous situation.
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‘ Review

The Eraser

The ability to erase is an excellent example of the
flexibility of MacPaint’s program design. The two pri-
mary ways to erase are selecting the eraser and drag-
ging it over the part of the drawing you want to
remove, or double-clicking the mouse on the eraser
icon, which clears the entire drawing screen. When
you click on the eraser icon, a box about a quarter inch
square appears on the screen (see Figure 8). This
shape is quite unwieldy if you need to erase a small
section of a detailed drawing.

An efficient way to erase is to “paint with white.”
Choose the white pattern from the pattern palette and
the paintbrush from the tool palette, select a brush
shape, and then paint over the portions of the drawing
that you want to erase. The advantage of this tech-
nique, although it is a little more complicated than sim-
ply selecting the eraser, is that the wide choice of
brush shapes allows you to be much more precise in
what you remove.

FatBits

One of the great qualities of this program is that
any drawing you create on the screen can be cleaned
up at the single-dot level. So what if the line you drew
with the pencil is a bit jagged? All you have to do to
improve details of your work is select the FatBits fea-
ture, either by pulling down the Goodies menu and
choosing the FatBits option or by double-clicking on
the pencil icon. An enlarged dot-by-dot pattern of a
section of your drawing (determined by the location
of the last screen activity) is displayed, as well as an
overall picture of the entire drawing in the upper-left
corner of the screen (see Figure 9). In FatBits, the pen-
cil can either insert or erase a dot, and you can watch
the success (or failure) of your efforts in the insert
screen in the corner. When you’re satisfied, a single
click in the insert screen returns you to the full
drawing.

This is a remarkable capability. FatBits enables
you to zoom into the 99,840 dots that make up the
MacPaint screen and manipulate each individual dot.
This ability to work on details, coupled with the vir-
tually inexhaustible supply of scrap paper that the
eraser gives you, allows anyone, with or without any
artistic skills, to turn out respectable drawings with
minimal practice.
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Mac Painting

Figure 2
You can choose from among the 32 paintbrush shapes shown
in the Brush Shape option.

Figure 3
Paintbrush strokes are more attractive and less difficult to
create than freeform lines drawn with the pencil.
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Figure 4
Filled and bollow rectangles can be enbanced using any of
the patterns and the various border widths.
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The Short Cuts option from the Goodies menu provides a guide to the keystroke combinations and their functions.

The Overall Picture

A MacPaint drawing, and any operations per-
formed on that drawing, can have either the loose
quality of a freehand sketch or the precise hard edge
of an engineer’s or draftsman’s work. At the touch of
an icon, a wide array of graphics and design capabili-
ties become possible. It’s hard to predict what effect
this machine will have on architects, art directors, en-
gineers, and artists. But for the first time an extremely
sophisticated drawing program is available at a very
reasonable cost, and accessible to almost anyone. Com-
pared to the more expensive CAD/CAM (computer-
aided design/manufacturing) programs available on
other personal computers, MacPaint is much more
usable, useful, and fun. It opens doors to people who
could never before create art because they didn’t have
the “talent”

At the same time, for all its scope MacPaint is not
a program without problems. For instance, it is very
frustrating to have no full-page drawing capabilities.
This means that it is impossible to draw a circle larger
than one drawing screen (about one third of a page.)
Furthermore, at present the program lacks the three-
dimensional drawing aids essential in the design of
tools and buildings. It would also be helpful to be able
to rotate a drawing or a section of a drawing (or, for

that matter, a line of text) in degrees or increments,
not just the right-angle turns currently possible.

But in light of the complexity that MacPaint al-
ready has, all of that can’t be far away. It will be inter-
esting to see how the professional art world reacts to
the program. I suspect, considering the howls of pro-
test that always greet the new, that those with the most
vested in the status quo will be the most critical. After
all, if you've spent ten years setting yourself up as an
expert draftsman, you're not going to enjoy the idea of
a horde of schoolkids, secretaries, and stockbrokers
being able to do it better than you can, and in less
time. The reality, of course, is that many talented artists
will flock to the Mac with its MacPaint program. One
can hardly imagine the legacy of images that this pro-
gram will produce, and I for one can hardly wait.

dddddddddd

MacPaint

Apple Computer, Inc.

20525 Mariani Ave.

Cupertino, CA 95014
800/538-9696; in California
800/662-9238

List price: $195 including MacWrite
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The current commeon wisdom accepts that computers
have revolutionized the craft of writing. A half hour of
creating words with the Macintosh will convince you,
however, that the real revolutiori[in writing has only just

Figure 1

A MacWrite text window with an insertion point (after begun) and an I-beam pointer (after revolution)

Which Format Rules?

MacWrite is not distinguished from
other word processing programs just by
ease of use. It can perform some flashy
screen formatting feats, all of which are
controlled by the MacWrite ruler system.
At the top of each document window, Mac-
Write displays a ruler that controls five for-
matting conventions: margins, indentation,
tabs, line spacing, and justification (see
Figure 3).

You can adjust text to fit within your
chosen margins by positioning two black
triangles (markers) along the ruler. In
keeping with the Macintosh style of opera-
tion, you don't specify the margins with a
command—you actually move the mark-
ers along the ruler by dragging them with
the mouse. Whenever the margin markers

are moved, all text below the ruler is auto-
matically readjusted to the new settings.
This is a good example of the type of fea-
ture that new Mac users may take in stride,
while computer veterans let out cool
whistles.

A small arrow-shaped marker in the
ruler governs the location of each para-
graph indentation. You can also “outdent”
paragraphs, which means that the body of
the paragraph is indented after the first
line. All indentation changes are reflected
immediately on the screen.

Tabs are set in the same manner. Each
new document comes with a tab marker
set at the 5-inch mark on the ruler. You can
reposition the marker by dragging it along
the ruler; additional tabs can be set by
dragging them out of the tab well (a box
on the lower-left side of the ruler) and
positioning them along the ruler. Decimal
tabs are also provided to position typed
numbers with the decimal points aligned.

Three line-spacing options are avail-
able: single, double, and line-and-a-half
spacing. You select them by clicking one of
three appropriate icons in the ruler bar,
and the new spacing is immediately re-
flected on the screen. The meaning of
these three icons is so obvious that you can
ask new users to “choose double spacing,”
and they’ll probably get it right on the
first try.

Four other icons let you format text as
left-justified, centered, right-justified, or
full-justified, which makes both left and
right margins even by adding letter spaces
within each line. Again, you see your
changes immediately reflected on the
screen.
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The MacWrite formatting features let
you experiment interactively with the way
your text fills the page. If you want to pro-
duce a one-page memo and find that you
have three lines too many to fit on the
page, just move the margin markers out a
bit until the text fits. You can also reformat
the memo to see what it looks like double-
spaced, indented, or centered.

If you want to change formats in the
middle of 2a document, you insert another
ruler and designate new settings (see Fig-
ure 4). Ruler settings can also be copied
from one part of a document to another.
You can insert new rulers in the middle of
a page or even in the middle of a para-
graph, changing margins, spacing, and jus-
tification with a click. As you'd expect,

Figure 2
The word revolution
selected

Figure 3

A MacWrite ruler show-
ing margins at 17
and 6 inches, indenta-
tion at 2 inches, single
spacing, and left
Justification.

inserting a new ruler and changing the for-

mat settings instantly reformats the text be-

low it.

These formatting features will have a
profound effect on how you view word
processing. You can control the formatting
process so responsively that you won't
think of your text as a static collection of
characters and spaces. Suddenly, it’s a fluid
body of writing that can be shaped in-
stantly to your specifications. Few writers

have ever had such control over the look of

their work.
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The Macintosh Style

Another innovative feature in Mac-
Write is the system of specifying type
styles, sizes, and fonts. At any point you can
select Style from the menu bar and choose
atypographic enhancement from among
plain text, bold, italic, underlined, outlined,
or shadow. You can mix these effects to
produce bold italic underlined shadow
text, or, if you're prone to hyperbole, bold
italic underlined outlined shadow text. The
Style menu also provides for type sizes
ranging from 9- to 72-point type. Make that
18-point bold italic underlined outlined
shadow text (see Figure 5).
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The current common wisdom accepts that computers
have revolutionized the craft of writing. A half hour of
creating words with the Macintosh will convince you,
however, that the real JEUIUIBEN in writing has only just
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writing has only just begun.
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The current common wisdom accepts that
computers have revolutionized the craft of writing. A
half hour of ¢reating words with the Macintosh will
convince you, however, that the real revolution in I

Up to now, word processors —- for all their
editing, searching, sorting, and paginating power --
have remained greatly glorified electronic typewriters.
But with the arrival of Macintosh, the scope of
computer writing skills is no longer confined to
stringing characters together. The power to control
typography and format has been put directly in the
hands of every writer. The art of writing has never
been so dramatically changed since Gutenberg.




Whatever styles are set define the ap-
pearance of text subsequently typed. But
you can also change existing text by select-
ing any portion of a document, from a sin-
gle character to the entire body of text, and
making a selection from the Style menu. If
you're already anticipating that these type
changes are reflected automatically on the
screen, you're becoming a convert to the
Mac style of word processing

The type possibilities may extend be-
yond your expectations. You can specify

the same line (see Figure 6). And when you
later insert text in your document, the in-
serted text automatically appears in the
specified style.

To be fair, all this praise should not be
directed to MacWrite. These typographic
acrobatics are provided courtesy of the
Mac's resident Font Manager—routines
that reside within the computer’s perma-
nent memory (ROM). Those font manipula-
tions are therefore equally available to all
other Mac applications, They will become

different type styles, fonts, and sizes within

r b |
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so much a part of the Mac style of comput-
ing that we will eventually come to expect
them from almost any program that runs
on the Mac.

The Bit of Difference

The Mac and MacWrite can do all
these wonderful things because they treat
writing as graphics rather than as just a
string of characters. The letter a is not just
the first letter of the alphabet; it's a 12-point
plain New York 4, a 10-point bold Athens 4,
a 24-point italic Venice a, or whatever com-
bination of variables you choose. MacWrite
“knows" this, and “tells” the Mac Font Man-
ager to “tell” the screen to display a 10-
point bold Athens 4, for example (see
“Chart of Type Fonts").

Figure 4

A MacWrite ruler with
margins sel at 2 and 5
V4 inches, indertation
at 274 incbes, line-
and-a-balf spacing,
and full justification

Figure 5§

MacWrire's Style mernu,
with the word revolu-
tion sef in 18-point
bold italic underlined
outlined shadow text
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The screen can display the letter in
this form because the computer has con-
trol of each of the 175,104 dots that make
up the total image on the screen. The Mac
screen is bit-mapped, meaning each of
those dots is controlled in the Mac’s mem-
ory. Thanks to the Mac’s ability to display
text in bits, every MacWrite writer has
been given the power to be his or her own
typographer and graphic designer.

The Limit

Now for a dose of reality. Based on the
introductory state of the Mac, each Mac-
Write document is limited to about 27,000
characters, or about 5000 words, which is
roughly the length of this review. It's about
20 double-spaced pages in 12-point type.
That's certainly more than enough space to
write your next office report or a long,
chatty letter, but you might find yourself

Figure 6

A variety of MacWrite
type styles and fonts in
a single document

66  Volume 1, Number 1

running out of space just as you're keying
in the climactic ending of your short story.

The immediate reason for this docu-
ment size limit is that a good chunk of the
Mac’s random-access memory (RAM) is
taken up by the programs that control the
Mac’s desktop and the MacWrite program
itself. The remaining RAM is what you have
available for your document.

The real limitation, however, is the
fact that MacWrite holds the entire docu-
ment in memory while it is being worked
on. There are other methods by which
word processing programs handle docu-
ments, such as by writing portions of the
document back to disk when necessary.
This method permits a document length
limited only by disk storage space. In com-
puter parlance, such a storage system is
said to be disk-resident, as opposed to the
memory-resident system that MacWrite
uses.

If you've got a lengthy writing project
and can’t manage to chop your material
into 5000-word chapters, two solutions to
this memory-bound limitation are possible.

& File Edit Search Format Font Style

One is to wait until more memory be-
comes available for the Mac. If a Mac had
512,000 bytes of memory installed, the
maximum MacWrite document would the-
oretically be about 400,000 characters,
which is the size of a short novel. But that
might be too long a wait for your immedi-
ate writing needs.

The second solution is to wait until a
word processing program is introduced for
the Mac that uses a disk-resident document
system. Several such programs are under
development and forthcoming. By the
time you read this, you might not have to
wait at all.

Old Traditions

Now that you've been wowed by Mac-
Write's features and have come to terms
with its Achilles’ heel, how well does it per-
form the standard operations that most
word processing programs provide? The
following is a brief rundown of some of the
essentials.

Insert and overwrite. All text is in-
serted in the document as it is typed at the
insertion point. You cannot overwrite char-
acters—that is, type characters in place of
existing ones. Limiting MacWrite in this
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will convince you, however, that the real
revolution in writing has only just begun.

Up to now, word processors —- for all their
editing, searching, sorting, and paginating
power -- have remained greatly glorified
electronic typewriters. But with the arrival
of Macintosh, the scope of computer writing
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way is a wise choice, given the general
Macintosh edict that application programs
should not place users in different modes
of operation.

Backspace. The Backspace key moves
the insertion point one character to the left
while deleting the character to the left; in
other words, it is a destructive backspace.
Seasoned writers and poor typists proba-
bly use this key more than any other.

Delete. The MacWrite program
provides three ways to delete text. The
Backspace key deletes destructively as de-
scribed above. You can also delete by
selecting a portion of text and choosing
Cut from the Edit menu. The cut text
then resides in the Clipboard, ready for
further use.

The third deletion technique is the
most innovative and also the most useful. If
you select a portion of text and start typing
new text, the selected text will be deleted
and the new text inserted as you type, all
in one automatic operation. It's the hand-
iest way to make a spot correction. Pressing
the Backspace key when text has been se-
lected deletes that text without cutting it to
the Clipboard.

Move and copy. Moving a block of
text in MacWrite is accomplished by select-
ing the text, cutting it to the Clipboard via
the Edit menu, choosing a new insertion
point, and then pasting the text from the

& File QAL

Clipboard into the document (see Figure
7). As an alternative, text can be copied to
the Clipboard, leaving the original text in
place and making the Clipboard text
available for pasting elsewhere in the
document.

This moving operation is fairly effi-
cient in that it can be accomplished entirely
with the mouse, but it does require that
you move from the text area to the menu
bar and back again twice. An alternative
method that uses the % (Command) key is
a very efficient way to make these moves
(see “Keyboard Control”).

Search and replace. The Search op-
tion on the MacWrite menu bar has com-
mands for finding a specified string of
characters and either selectively or
globally changing the “find” string to an-
other string (see Figure 8). Both functions
ignore case; that is, if you are searching for
Mac, you will find Mac, mac, Macys, and
supremacy.

MacWrite's search and replace func-
tion is somewhat limited. Other word pro-
cessing programs allow you to specify
whether you want to ignore case. A further
refinement is whether the replace string is
inserted in a “case-sensitive” manner. In
other words, if you are finding Mac and

Search Format Font Style

Up to now, word processors -- for all their editing,
searching, sorting, and paginating power -- have remained
greatly glorified electronic typewriters. But with the
arrival of Macintosh, the scope of computer writing skills
is no longer confined to stringing characters together. The
power to control typography and format has been put
directly in the hands of ¢very writer. The art of writing
has never been so dramatically changed since Gutenberg.

changing it to Sack, both Mac and mac
will be changed to Sack and sack respec-
tively. A flexible range of search and re-
place options is the sort of detail that in
the traditional word processing world
distinguishes a good program from a
great one.

Bells and Whistles

The word processing world is filled
with other fancy features. Some programs
let you store different formats for memos,
letters, and outlines and implement them
with a single command; edit several docu-
ments at once using multiple windows;
create footnotes, tables of contents, and in-
dexes automatically; or define certain key-
strokes to type whole words, phrases, or
sentences or to define a series of program
commands into “macro” commands. Some
programs even check your grammar and
spelling. MacWrite does not offer any of
these extra treats.

MacWrite does offer one rare and wel-
come feature, however. The Undo com-
mand in the Edit menu always gives you
the option of undoing your last action.
Thus, you can undo deletions, moves, style
changes, and even the last text typed as an
insertion. It’s like having a word process-
ing seatbelt, only more effective, because
you're always wearing it and it can take you
back in time, before the accident occurred.

What’s more, in classic Macintosh
style, the text of the Undo command
changes to reflect your last action. For ex-
ample, if you are undoing a Cut command,
the prompt will say Undo Cut. If you
choose Undo twice in succession, the sec-
ond time the prompt will say Redo Cut and
undo your previous undo. It’s a powerful
dose of Mac magic.

Figure 7

Choosing the Cut com-
mand from the Edit
menu to cut selected
text into the Clipboard
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writing has only just begun.

Two Reviews

Now it may be more apparent why this
review is really two reviews. Compared to
the mundane functions of the word pro-
cessing programs that preceded it, Mac-
Write holds its own as a perfectly
serviceable, if somewhat limited, word
processing package. It’s an appropriate
program for beginners because of its sim-
plicity. Some features could have been bet-
ter designed, and many bells and whistles
exist in the word processing world that
MacWrite doesn't pretend to offer.

convince you, however, that the real revolution in

Up to now, word processors -- for all their
editing, searching, sorting, and paginating power --
have remained greatly glorified electronic typewriters.
But with the arrival of Macintosh, the scope of
computer writing skills is no longer confined to
stringing characters together. The power to control
typography and format has been put directly in the
hands of every writer. The art of writing has never
been so dramatically changed since Gutenberg.

But for new computer writers and
word processing veterans alike, MacWrite
also provides the first widely accessible
version of a revolutionary new style of
computer writing tool. It excels in the
areas of screen formatting and type selec-
tion. MacWrite does amazing things
effortlessly that most other programs can't
even attempt. Without question, no word
processing program has ever offered so
much power with so much simplicity to
such a wide audience.

This is why every writer, regardless of
his or her computer experience, should be
thrilled by MacWrite. The Macintosh is

Figure 11
Pasting text to the
Scrapbook

Figure 12
The File/Print menu

going to change the way we think about
written communication. MacWrite is the
first popular program to show us why
and how.
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MacWrite

Apple Computer, Inc.

20525 Mariani Ave.

Cupertino, CA 95014

800/538-9696; in California
800/662-9238

List price: $195 including MacPaint
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More important than size alone is the
fact that Multiplan resides in the com-
puter’s memory. The Mac is very good at
keeping track of things, doing error-free
calculations, and letting you change the
appearance of the display.

The speed of a Multiplan spreadsheet
calculation clearly manifests the power of
electronic spreadsheets. A simple example
is adding up a column of numbers. Multi-
plan has a function that does this in less
time than it takes to dot an 7. You can
change a number in the list, and the pro-
gram will recalculate the total (along with
every other formula and function on the
worksheet) and display the new answers in
a flash.

“What If” analysis—changing a few
numbers to see what will happen to a bud-
get, a balance sheet, or any other table—is
an important financial analysis tool. It is
one of the tasks that Multiplan and other
electronic spreadsheet programs do best.
The results of a few simple changes that
may take hours of manual calculation (al-
ways subject to human error) are pre-
sented error-free by the computer in
seconds.

Another important feature of an elec-
tronic spreadsheet is its ability to insert or
delete space in the middle of an already
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IN 1967 DOLLARS

. $16,038.49

 $17,746.23
$18,903.5

83220612
$49,261.08

constructed table. Never again will you
have to use scissors and paste to remove an
unwanted row or column. Never again will
you need to resort to microscopic writing
to include a line item you missed or an
item someone suggested you consider. Fur-
thermore, every formula and function on
the worksheet adjusts automatically to ac-
commodate the new rows or columns.

Electronic spreadsheets, along with
word processing programs, are what keep
microcomputers from being merely expen-
sive toys. These programs give you great
control over two of humankind’s most es-
sential means of communication and analy-
sis: words and numbers.

Also, spreadsheets and word process-
ing programs do not require that you use
specific tools to solve problems in pre-
determined ways. Instead, they provide
two general types of electronic “black-
boards” and “chalk boxes.” These are gen-
eralized tools that let you decide how best
to solve your particular problems based on
your individual knowledge and creativity.

Figure 1

Sample Multiplan
spreadsheet docu-
menting the sad
decline of the pur-
chasing power of
the U.S. dollar.

MacPlan

Mudtiplan is the first spreadsheet pro-
gram available for use on the Mac. But it is
such a different version of the well-known
product that those familiar with it might be
tempted to call it “MacPlan.” If you have
used Multiplan before, you'll recognize
the program, but there are many new—
and worthwhile—things to learn. The uni-
form working environment of the Mac—
windows, icons, pull-down menus, and the
like—and the use of the mouse for cursor
control have important, positive effects on
the way Multiplan operates.

Figure 1 shows a typical Multiplan
window. It displays a table documenting
the sad decline of the purchasing power of
the US. dollar. The menu bar at the top of
the window lists the Multiplan menu titles:
Folder, Edit, Select, Format, Options, and
Calculate. Most of the program features are
selected by choosing items from one of the
menus. Each menu can be pulled down by
locating the pointer on the desired menu
title and pressing and holding down the
mouse button.

You can select items from the menu by
moving the pointer to the appropriate item
and releasing the mouse button. The
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checks opposite Dollar, Align Center, and
Commas in Figure 2 indicate that those
three formats control the display of the
number in the cell shown in black in the
body of the worksheet.

The line below the menu bar is the
Jormula bar. The left side of the formula
bar contains the address of the active, or
current, cell in the body of the worksheet.
In Figure 1, the active cell is at the intersec-
tion of row 13 and column 3. Hence, the ad-
dress of the active cell is R13C3. Each cell
on a Multiplan worksheet has a unique ad-
dress made up of the row number and col-
umn number of the cell’s location.

The active cell is the only cell in
which information can be placed or modi-
fied. It is displayed as black with a solid
white border, making it easy to spot. The
contents of the active cell are displayed on
the right side of the formula bar. In Figure
1, the active cell contains a formula
(=20000/RC[-1]), even though it displays
the number $57,471.26 in the body of the
worksheet. The formula tells Multiplar

what it must do to find out how much you
would have needed to earn in June of 1982
to have the average purchasing power of
20,000 1967 dollars.

The denominator of the expression,
RC[-1], is how Multiplan refers to cells
within formulas. It means, “Get the value
from the cell in this row (R), but one col-
umn to the left (C[-1]).” This type of cell
reference can become very complicated
when you are referring to ranges, and it is a
major reason Multiplan’s ability to assign
names to ranges is so essential.

The Mouse

One of the prominent features of the
Mac is the mouse. While you’ll need some
practice to get the right hand-eye coordi-
nation to move the pointer with the mouse,
the power and convenience it brings to
Mudltiplan are well worth the effort. (Some
commands can be implemented from the
keyboard. These key combinations, which
are listed next to the equivalent commands
in the menus, are convenient when you are
keying in data.)

The action controlled by the mouse
depends on the location of the pointer on
the screen. To help you distinguish the ac-
tions, the pointer changes shape as the ac-

Figure 2

Sample Multiplan
menu. The checks op-
posite Dollar, Align
Center, and Commas
indicate that those
three formats control
the display of the num-
ber in the active cell.

tion changes. When the pointer is in the
menu bar, it is arrow shaped and can be
used to pull down menus. When the
pointer is in the body of the worksheet, it
is a cross and is used to activate cells. In
the formula bar the pointer is an I-beam
and indicates where editing will take place.

If you move the pointer to one of the
vertical lines that separate the column
numbers, the symbol changes to indicate
that you can change the column width by
dragging the boundary to the right or left.
(Column 3 in Figure 1 has been expanded
to accommodate the large column head-
ing.) When an action requires a few mo-
ments to complete, the pointer changes to
a wristwatch to indicate that you must wait.

While they do take some getting used
to, the context-sensitive symbols are an ex-
cellent visual guide to what will happen
when you work in different areas of the
Multiplar window. The mouse is a conve-
nient way to choose options from a menu,
and can quickly accomplish such routine
tasks as selecting a range of cells, changing
column widths, or splitting the screen into
separate window panes.
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Scrolling the Worksheet

Only a small fraction of the Multiplan
worksheet appears in the grid in the lower
part of the screen in Figure 1. Although the
number of cells displayed depends on the
width of each column, usually fewer than
100 cells are visible on the screen at any
time. Actually you have plenty of room to
work with, since the worksheet in the
Mac’s memory has 16,065 cells.

The general procedure for making dif-
ferent cells appear on the screen is scroll-
ing the worksheet. This term refers to the
way the worksheet appears to wind and
unwind on the screen. Since you will use
scrolling frequently when you are con-
structing or using an electronic worksheet,
the way a program handles this function is
very important. One of the Mac’s greatest
strengths is that it performs these opera-
tions efficiently.

The easiest way to expose cells that
are just off the screen is to position the
pointer at the edge of the grid. Pressing
and holding the mouse button while you
move the pointer into the border causes
new rows or columns to appear.

If you want to view distant cells, the
Mac has some particularly efficient ways to
get you there. Multiplan uses the scroll
bars, scroll boxes, and scroll arrows that
are standard equipment on most Mac win-
dows (see “A Tour of the Mac Desktop” for
a detailed description of these features). By
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using the pointer to position the scroll
boxes in the horizontal and vertical scroll
bars, you can quickly and easily cause any
of Multiplan’s 16,065 cells to appear on the
screen.

Window Bars

Another feature of Multiplan is the
window bar. This is the small black rec-
tangle at the top of the vertical scroll bar
and at the far left of the horizontal scroll
bar. You can position the pointer in a win-
dow bar, hold down the mouse button, and
drag the window bar along the scroll bar.
The screen will split into two windows at
the point where you release the mouse
button (see Figure 3).

Unlike a similar feature on other elec-
tronic spreadsheets, you cannot scroll all
windows independently. Windows above
one another must display the same col-
umns, and windows beside one another
must display the same rows. However, win-
dows on the diagonal can be scrolled inde-
pendently. You can view different sets of
cells in the upper-left and lower-right win-
dows. Thus, you can display an entry space
(a place where you enter parameters) in
the upper-left window and, at the same
time in the lower-right window, a set of far-
removed cells that form display output.

Figure 3

Multiple windows
allow you to view
different sets of cells.

Selecting Cell Ranges

Many of Multiplar’s built-in functions
and commands operate on all cells in a
group or range of cells. The SUM function
is an obvious example. It adds up the num-
bers in a range and displays the answer in
the cell containing the function. Another
example is the Format command, in which
all the cells in a range can be assigned the
Dollar format or aligned to the center of
the cell, for example.

To operate on a range of cells, the pro-
gram must provide ways to select the cells.
Mudltiplan gives you several ways to accom-
plish this task. In fact, there is nothing like
it on any other electronic spreadsheet pro-
gram. You can select an entire column or
row by positioning the pointer on a row or
column number and clicking the mouse
button. Like all selected ranges, the se-
lected row or column will appear in re-
verse video (white characters on a black
background).

Or you can position the pointer on the
first cell of the range, hold down the but-
ton, and drag the pointer to the opposite
corner of the desired area. The area may









In addition to their use in linking
worksheets, named cells or ranges of cells
are convenient to use with all spreadsheet
functions. In Figure 5, the Consumer Price
Index in column 2 of the spreadsheet in
Figure 1 has been given the name “CP1”
This name is used in place of cell refer-
ences in the formulas in column 3. The
formulas are much easier to read and
understand when CPI replaces the cell ref-
erence, RC[-1]. This procedure is even
more useful when a name replaces a range
of cells in a formula or built-in function.

You can use the Name option from the
Select menu to view all of the names you
have assigned and to see which cells are as-
signed to each name. The Paste Name com-
mand in the Edit menu allows you to paste
a name into a formula without having to re-
type the name.

Entering Data and Text

The Mac version of Multiplarn has a
good method for entering information into
worksheet cells. First, you use the pointer
to define the range into which you wish
to make your entries. After selecting the
range, you type your entry and press Enter.
The active cell, which is outlined in white,
will automatically move to the next cell in
the range.

You can skip cells by pressing Enter,
and you can return to cells in which you
have already entered information by simul-
taneously pressing the Shift and Enter keys.
This technique works with the Paste Func-
tion and Paste Name commands, as well as
with numbers, formulas, and text. You must
be careful not to use the Return key in-
stead of the Enter key; pressing Return will
cancel the range.

Flaws in the Plan

Set off against an impressive list of
strengths are three problems. The first is
Mudtiplan’s inability to scroll each pane of
a split screen independently. As noted, only
diagonal windows can be scrolled inde-
pendently, and independent scrolling is
necessary to view widely separated sec-
tions of a worksheet. The split screen is

The relatively
small size of the Mac
screen is a drawback.

most often used when you are performing
What If analysis with large tables, and non-
independent scrolling means wasting
about half of an already small screen to
obtain the two independent diagonal
windows.

The relatively small size of the Mac
screen is also a drawback. When Multiplan
first appears on the Mac screen, it displays
84 cells in 14 rows and 6 columns. In con-
trast, Mudtiplan displays almost 75 percent
more cells—140 in 20 rows and 7 col-
umns—on the IBM Personal Computer.
Having more cells on the screen at one
time makes working with a worksheet
easier. In fact, the major selling point of
some microcomputers is that they display
132 characters across the screen at one
time and are therefore well suited for work-
ing with spreadsheet programs.

The final problem is related to the
Mac’s uniform working environment, not
to a specific application program. When
you want to erase files, including Multiplan
worksheet files, the Mac requires that you
take them from the desktop and place

them in the Trash. This operation must
take place at the disk window level either
before you enter Multiplan or after you
have left the program.

The use of icons and a uniform way of
doing similar tasks in all application pro-
grams is certainly one of the Mac’s greatest
strengths; it helps you move from one ap-
plication to another easily and with a mini-
mum of training. But in this case, the
uniform environment is a drawback. Most
people want to have one last look at a
worksheet before consigning it to elec-
tronic purgatory, and with the Mac you
can’t do that. What you must do is keep a
list of the files you want to discard in the
Trash, and then do the operation after
you've left Multiplan. Microsoft should def-
initely put a Delete File command in the
File menu.

These few objections aside, the most
exciting thing about Multiplar on the Mac
is the way the classic strengths of a solid
spreadsheet program team up with the
latest technology to produce a winning
combination. Many people will undoubt-
edly find using the mouse an easy and nat-
ural way to select cells, split and scroll
windows, and edit formulas. The pull-
down menus and dialog boxes are more
important features, however, because they
make Multiplan easier to use than ever be-
fore. And you simply cannot make a spread-
sheet program too easy to use.
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Multiplan

Microsoft Corporation
10700 Northup Way
Bellevue, WA 98004
206/828-8080

List price: $195
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Printing Options

In most applications, a dialog box ap-
pears when you choose the Print com-
mand (see Figure 4). It lets you choose
how much to print and the quality of the
print resolution. Your choice of print qual-
ity—draft, standard, or high—determines
how closely the printed image will match
the displayed one.

Draft quality printing ignores pictures
altogether and prints characters in one
font, with no variation in style or size. Both
standard and high quality printing re-
produce pictures and text exactly as dis-
played. Standard quality images look
exactly like those displayed on the screen,
but high quality images have about twice
as many dots, giving them a fuller, denser
appearance. Figure 5 illustrates the differ-
ences among the three printer resolution
qualities and the screen resolution quality.

The print resolution quality also af-
fects how fast the Imagewriter prints. Draft
quality is fastest, because it simply sends
out a code for each character. The Im-
agewriter translates those codes into dot
patterns, using its own built-in character
font. The nominal print speed for draft
quality is 120 characters per second.

Standard quality is somewhat slower
than draft quality, because it sends dot pat-
terns, not character codes, to the printer.
The average print speed for standard qual-
ity is 90 seconds per page. High quality is
slowest of all. It sends two sets of dot pat-
terns for every line, so the Imagewriter has
to make two passes across each line. The
average print speed for high quality is 165
seconds per page.

Solid Ok Fife Cabinel

Replica of the one in grandfather's
office. Matches our roiitop desk
{see p. 21) and oak office chairs

{see p. 19) for a complete set.
Hand-rubbed tung oil finish in
your choice of natural, light
oak or dark stained oalk.

FCeDzZ427L....... light oak......$195
FC602427D.....dark oak...... $195

Shipping weight, 75 ibs.

Figure 3

Faint lines caused by
baper shift. Quality
single-sheet stationery
minimizes this
problem.
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group meeting next week.

Figure 4

Printing options. This
dialog box appears
when you choose the
Print command.
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1. Moving Date: Let's wait awhile. Discussing the moving date

Macworld 83






http:Print.or
http:Image\Al!'it.er



















program helps to calculate the
costs of running a business. You
can create worksheets to calcu-
late manufacturing overhead,
unit costs, costs of goods sold,
and sales and administrative ex-
penses, as well as sales budget
worksheets to project
revenues.

The Operating Budget work-
sheet copies data from other
worksheets and calculates the
contribution margin and net
operating income for products,
and can demonstrate the ef-
fects of changes in unit sales
volume,

The Variance Analysis work-
sheet is a budget control tool
divided into three sections: the
budget variance summary
shows variances between ac-
tual performance and results
forecasted in the Operating
Budget worksheet; detailed
variance analysis shows vari-
ances for sales volume, produc-
tion costs, fixed overhead, and
sales and administrative ex-
penses; and worksheet data
provides a matrix in which to
enter data used to recalculate
the summary and detail sec-
tions of the Variance Analysis
worksheet. Available during
the second quarter of 1984. List
price: $100.

Microsoft Cash Budget

A program that monitors cash
flow to provide managers with
accurate data for marketing, fi-
nance, and sales decisions.
Cash Budget creates five Multi-
plan worksheets to detail cash
flow and show net cash flow.
The first four determine cash
inflows from sales, cash out-
flows for purchase of materials
and merchandise, cash flows
from operations, and non-
operating cash flows. Cash
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% Y
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Microsoft Chart, Microsoft Corp.

Budget then consolidates those
results to produce a net cash
flow position for each interval
selected. The final result works
as a planning and strategy tool.
Available during the second
quarter of 1984. List price: $100.

Microsoft Chart

A program that translates nu-
meric data into graphic form to
illustrate relationships or com-
parisons presented by the data.
Users assign information to a
set of categories; each category
has a corresponding value. The
category-value sets form data
points, which may be com-
bined to form up to 64 data
series.

Once data has been assem-
bled, users choose a basic chart
type from the Gallery menu,
depending on their objectives
for presenting the data, the de-
vice on which the chart will be
printed or displayed, and the
amount or type of data in-
cluded. The program allows for
changes in shadings, colors,
line thicknesses, and positions
of titles. Shading and line for-
mat options are presented in di-
alog boxes.

The mouse is used to select
objects on the chart and move
them to different positions.
Text placement on charts is
user controlled. A group of

charts can be created on
screen, or two or more charts
can be overlaid. Charts auto-
matically reflect changes to
data series. Available during the
first quarter of 1984. List price:
under $200.

Microsoft File

A nonprocedural tool that helps
individuals maintain personal
data files. The program offers
forms-based data entry and re-
trieval. Users select a format for
data entry suited to their per-
sonal file management needs
from a gallery of standard data
forms. Users can adapt data
forms by determining the num-
ber of fields, field sizes, and
field designations, and by se-
lecting data orientation by col-
umns or rows.

File’s reporting capabilities
include sorting and summing
on any field, simple mathemati-
cal operations, averages,
counts, and logical operators.
The interactive program per-
mits users to transfer data
entered in it to other applica-
tions. Available during the first
quarter of 1984. List price:
under $200.

Microsoft Financial
Statement

An evaluation tool that assesses
a company’s financial perfor-
mance. The program helps
users create balance sheets and
income statements based on
periods (e.g., quarters or
years) they select. Using work-
sheet data, Financial State-
ment automatically calculates
18 financial performance ratios
used by accountants and finan-
cial professionals. The ratios
are divided into four catego-
ries: liquidity, leverage, prof-
itability, and efficiency. Users
are then able to gauge their
firm’s ability to service current
and long-term debts, to meas-
ure net returns, and to evaluate
how efficiently company re-
sources are being used. Avail-
able during the second quarter
of 1984. List price: $100.

Microsoft Personal Finance
An interactive analysis tool for
personal financial planning that
addresses cash flow analysis.
Users can produce a financial
forecast through the develop-
ment of four worksheets. The
main worksheet summarizes
all sources and uses of cash and
includes a personal balance
sheet. The three supplemen-
tary worksheets can be used to
detail earnings, living ex-
penses, assets, and liabilities.
They can be linked to the main
worksheet for analysis. Cash
flow analysis enables users to
plan net worth positions with
variable net cash positions.
Available during the second
quarter of 1984. List price: $100.
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Portfolio Valuati on Wor ksheet

clanuary 24, 1954

Date:  |[i=lwien.. | 204

Stock Purchase Number Original Today's Today's  Dollar Percent Graph of |
Symbol Price Shares Cost Value Change  Change Per*centc§
AAPL $18.25 200 $3650 ES $4076 $426 11.67%
1BM $125.38 100 $12538 @ $12088 ($450) -3.59% i
DEC $82.75 100 $8275 $7163 ($1112) -13.44% [0
INTC $40.00 200 $8000 RSN $8400 $400 5.00% g . .
TOTAL: $32463 $31727  ($736)

Figure 6
Worksheet after Protect Document command is executed. The
unprotected cells are underlined and the active cell will move

ner of the block formed by cell R7C1 and R10C9. With
the pointer on R10C9, hold down the Shift key and
click the mouse button to select the block.

Next, choose the Fill Down command from the
Edit menu. Everything you specified for the cells of the
first row will be copied down the respective columns
to fill the rest of the cells in the range.

Totaling Your Position

You can total the Original Cost, Today’s Value, and
Dollar Change columns by placing the Multiplan func-
tion SUM in the appropriate cells along the bottom of
the table. The SUM function adds the contents of a
range of cells, and you can select that range either by
pointing or by naming the range.

Begin by entering the word TOTAL: into cell R11C1.
To see how the name feature works, name the range
for Original Cost. Locate the pointer on cell R7C4, hold
down the mouse button, and drag the pointer down to
cell R10C4 to select the range to be named. Pull down
the Select menu and choose the Define Name option.

from unprotected cell to unprotected cell each time you press
Enter.

A dialog box appears, and you can type in the name.
This group of cells contains the Original Cost for each
stock, so name it COST.

To sum the cells in COST, select cell R11C4 and
pull down the Edit menu. Choosing the Paste function
makes a dialog box containing all of Multiplar’s built-
in functions appear. Move the scroll box in the dialog
box until SUM() appears. Select SUM, and it will be
pasted into the formula bar.

Pull down the Edit menu again. This time choose
the Paste Name option. A dialog box containing all as-
signed names appears. So far you've only assigned one
name, COST. Choose COST, and it will be pasted into
SUM() to form the function SUM(COST). Finally, press
Enter to enter the completed function in cell R11C4.

Name the cells in the Today’s Value column VALUE
and those in the Dollar Change column CHANGE. Then
define the SUM functions for each of these columns.
You can use the Paste Name and Paste Function op-
tions, or you can type in the functions and names di-
rectlyas = SUM(VALUE) and = SUM(CHANGE).
When you are finished, the worksheet will look like
the one in Figure 3.
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fore inserting) in the middle of a para- "

graph and want to restore the paragraph to
its original state. Undo can be invoked
from the keyboard using 3 -z.

® Remember that there are four places
to which you can move and store text while
you are editing: the Clipboard, the Scrap-
book, the beginning of your document,

& File Edit Search Format Font Style

Clipboard
the real revolution in writing has only just begun.

and the end of your document. Each loca- EHUSESSS—————— Mac lliriting

tion has specific uses. The Clipboard is vol- The current common wisdom accepts that
atile—its contents are replaced with each computers have revolutionized the craft of writing. A
successive Cut or Copy. The Scrapbook half hour of creating words with the Macintosh will

stores text (or pictures) permanently and is
convenient for inserting stock text selec- a5 o1y |
tions several times within a document. Up to now
Don't overlook the beginning and end of editing, searching, sorting, and paginating power --
your file as convenient holding areas for have remained greatly glorified electronic typewriters.
;i’:(; ;%ﬁ!gggg:ﬂ’g‘: ::)lrlri é);;;fg:‘kmg But with the arrival of Macintosh, the scope of

1 computer writing skills is no longer confined to

® If you are doing a good deal of cut- e
ting and pasting, you might want to set up stringing characters together. The power to control

your screen with both the text area and the typography and format has been put directly in the
Clipboard in full view, serving as a perma-  Figure 2
nent on-screen reference (see Figure 2). Having the Clipboard in full view provides an
® The same screen arrangement is on-screen reference during cut-and-paste
helpful for aligning the page, date, and operations

time icons properly in the header or footer
windows. With both the header and footer

windows in view, you can adjust the icons

and then click the text window to see the & File I8 Search Format Font Style 1
effects immediately. O fan't Gnde %2 Mac Writing

Searching Cut 3H

The MacWrite Find and Change func- o : = =]
tions are useful if you need to change the Paste FT)

on wisdom accepts that
COME; . ionized the craft of writing. A
patf foonOll Lhiphoard | ;o with the Macintosh witl

name of a character throughout your short
story, but some of the best uses for the
Search capability don’t involve changes

per se. convince you, however, that the real revolution in

® If your text includes a key word that writing has only just begun.
is long or difficult to type, substitute a dis- Up to now, word processors -- for all their
tinctive, easily typed symbol while you're editing, searching, sorting, and paginating power --
doing your initial writing. Then change it have remained greatly glorified electronic typewriters.
during your final edit. For example, you But with the arrival of Macintosh, the scope of
could use the @ symbol and later change it computer writing skills is no tonger confined to
to Tehaikovsky. stringing characters together. The power to control

® MacWrite does not feature place
markers, but you can make use of the
Search function to guide you through your

typography and format has been put directly in the
hands of every writer. The art of writing has never
been so dramatically changed since Gutenberg.

Figure 3

Copying a ruler with a specified format into
the Clipboard for insertion elsewbere in the
document
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document. If you are moving a selected
portion of text to the beginning or end of
your document, embed a special symbol,
such as the + + symbol, in the text before
repositioning the pointer to complete the
paste operation. Then you can find your
original position easily by searching for the
+ + symbol.

@ When you want to replace a word
globally throughout your document with
the Change All command, be careful that
you don’t accidentally replace fragments of
longer words. Suppose, for example, that
you decided to change all occurrences of
Mac to Macintosh. If the word Macinitosh
were already in your document, it would
come out as Macintoshintosh. To avoid this
situation, you could include spaces as part
of the Find string: Mac[space]. Then your
search would look only for whole words.
However, your search would not find oc-
currences of Mac at the end of a sentence.

Another strategy would be to change
all instances of Macintosh to Mac first, and
then change all the Mac’s back. You would
still have to search for Mac[space], how-
ever.

o After wading through the above sce-
narios, you should see clearly that global
changes can have unexpected results. It’s
usually wise to take the time to confirm
each modification with MacWrite's
Change, then Find option.

Formatting

MacWrite has powerful formatting ca-
pabilities that let you set margins, indenta-
tion, tabs, line spacing, and type styles. You
can streamline your formatting chores by
using some of the following techniques.

® Most writers have standard writing
applications—letters, memos, draft man-
uscripts—that require different formats.
Take the time to determine the best format
for each of these situations, then save the
formats in separate files and use one of
those files to start each type of writing
project.

For example, suppose you like to pre-
pare drafts with 2-inch margins on both
sides of the page, double-spaced, using 14-
point Athens type. Start MacWrite and
open a new document. You'll see a blank
document called Untitled in the MacWrite
window. Without typing any text, move the
left margin marker to 2 inches and the
right to 6% inches, click on the double-

space icon, and select 14-point Athens type.
Then choose Save from the File menu and
name the document Draft Format. Now
every time you want to begin a draft, start
MacWrite by double-clicking on the icon
labeled Draft Format. You'll automatically
create a document with your chosen for-
matting features.

When you are ready to save your doc-
ument, don’t choose the Save command.
Instead, choose Save As... from the File

BN

The Scrapbook
stores text (or pic-
tures) permanently
and is convenient for
inserting stock text
selections.

menu. You'll be asked to give a name under
which to save the current document. At
this point you should give your written
document a distinctive name, such as Draft
Story 23.

Once you've copied and saved the
document under a new name, choose Quit
from the File menu, making sure that you
don'’t save your original Draft Format docu-
ment with all the text you added. The next
time you want to write a draft, start with
the Draft Format document again; it will
once again present a clean slate, formatted
according to your specifications.

@ You can expand the above technique
to create a correspondence format file that
produces your own customized letterhead,
complete with a MacPaint graphic, your
address, and the date.

® If you are creating a document that
uses several formats, such as an outline or
a screenplay, you'll want to be able to
switch formats quickly and easily. Before
you start writing, make up the different
rulers that you'll need and place them in a
“ruler well” at the beginning or end of
your working file. When you need a certain

format, such as indented single-spaced, you
can go to the well, copy the appropriate
ruler to the Clipboard, and paste it in place
(see Figure 3). This technique is much
faster than inserting new rulers and adjust-
ing the margins each time you need them.
(To select a ruler, click on the portion of
the ruler with the inch markings.)

® Note that the rulers carry formatting
information, but not type style and size
specifications. If you want to make those el-
ements part of your multiple formats, you
should include at least one blank line (two
Returns) with each ruler before you copy it
to the Clipboard. Then when you paste in
the ruler you'll include a spot in your doc-
ument that carries the appropriate type
specifications. As you insert text at that
spot, it will assume the specified format.
This technique will work, but it can be dif-
ficult at first to know exactly where the
boundaries are between different type
fonts and styles. Experiment and practice.

Bear in mind that the MacWrite win-
dow is not as wide as a standard sheet of
paper. In relation to an 8%-inch-wide sheet
of paper, the MacWrite ruler starts at 1 inch
and ends at about 7% inches. Thus, there
are margins beyond what you see on the
screen. If you adjust the screen to show
pleasing margins, your printed text may be
too narrow. (Don'’t be afraid to format your
documents with adequate “white space,”
however.)

® You should also note that Mac-
Write’s default format (the way the
program starts out, without any user
specification) does not include any head-
ers or footers. Unless you specify other-
wise, your printed document will start at
the top of each page and continue to the
bottom. If you want top and bottom mar-
gins, call up the Header and Footer win-
dows and insert two or three Returns
in each. These specifications can be
included in your document format files,
as noted above.
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90-100. When you press the mouse button
to select the top-left corner of the rec-
tangle you want to draw, the program goes
into another loop. First, it gets the mouse
coordinates and assigns them to variables
RIGHT and BOTTOM.

110. MBASIC expects the rectangle’s corner
coordinates in the first four elements of an
integer array; this program uses array R( ).

120. Calls Toolbox procedure frameRect to
draw the rectangle whose coordinates are
in array R( ).

130. The second call to frameRect erases
the rectangle just displayed; the result is a
flashing rectangle.

140. As long as you hold down the mouse
button, the program loops between lines
90 and 140, flashing rectangles sized by the
current mouse coordinates. MOUSE(O) has
avalue of -1 as long as the mouse button is
held down.

150-160. Changes the drawing mode and
permanently draws the rectangle at its final
location.

170. Branches back to wait until you select
the top-left corner of another rectangle.
(To halt the program, press the 8 and ¢
keys simultaneously.)

MacBASIC SimpleSketch

From a program user’s standpoint, the
MacBASIC version of SimpleSketch works
just like the MacPascal and MBASIC ver-
sions (see Listing 3). But a comparison of
the different versions of this program re-
veals disparities even between the two
BASIC versions. Unlike MBASIC, MacBASIC
does not require line numbers. (Note: the
numbers to the left of the program lines in
the listing pertain only to the following de-
scription of the program.) Also, MacBASIC
displays listings in upper- and lowercase
letters, although it treats capital letters and
their lowercase counterparts as the same
characters (unless they are between quota-
tion marks). MacBASIC, unlike MacPascal,
does not automatically format listings. To
indent program lines for better readability,
you have to type the spaces yourself by
pressing the space bar.
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program SimpleSketch
var
1— top, left, bottom, right : integer;
begin
2 penSize(l, 1);
3 repeat
q penMode(patHor);
5 while button = false do
getMousel(left,top);
6 while button do
begin
? getMouse(right,bottom);
8 frameRect(top, left, bottom, right);
9 frameRect(top, left, bottom, right);
end;
10— penMode(patCopy);
11— frameRect(top, left, bottom, right);
12 until false;
end.
Listing 1

MacPascal version of SimpleSketch. Command
words are in boldface and program lines are
indented.

10 REM SimpleSketch Program

20 DEFINTL,T,R,B

30 CLS

40 CALL PENSIZE(1,1)

S0 CALL PENMODE(10)

60 LEFT=MOUSE(1)

70 TOP=MOUSE(2)

80 IF MOUSE(0)=0 THEN GOTO 60

90 RIGHT=MOUSE(1)

100 BOTTOM=MOUSE(2)

110 R(1)=LEFT:R(0)=TOP:R(3)=RIGHT:R(2)=BOTTOM
120 CALL FRAMERECT(UARPTR(R(0)))
130 CALL FRAMERECT(UARPTR(R(0)))
140 IF MOUSE(D)=-1 THEN GOTO 90
150 CALL PENMODE(8)

160 CALL FRAMERECT(UARPTR(R(0)))
170 6OTO 50

Listing 2

Microsoft BASIC version of SimpleSketch.
MBASIC uses capital letters everywbere
except in program remarks.
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11. The program branches back to the ear-
lier do statement so that you can draw an-
other rectangle. (To halt the program,
choose the Halt command.)

The Oval Alternative

Like MacPaint, the original Sim-
pleSketch program uses the frameRect
procedure from the QuickDraw Toolbox
unit to draw rectangles and squares. With
MacPaint, you can also draw an oval by
selecting the rectangle it fits in, first choos-
ing the upper-left corner and then the bot-
tom-right corner. The key to drawing ovals
and circles is another QuickDraw pro-
cedure, frameOuval.

Drawing ovals the same way Mac-
Faint does is easy in the MacPascal pro-
gram; simply change the procedure name
in each of the three program lines in which
it occurs. With a little more work, you can
enhance the original SimpleSketch pro-
gram so it does something that can’t be
done in MacPaint. Listing 4 shows a Mac-
Pascal program, OvalSketch, that lets you
draw an oval by selecting the center point
and any corner of the rectangle into which
it fits. Figure 2 shows how it works, and Fig-
ure 3 illustrates the program output.

The following description explains
how OvalSketch works, with emphasis on
the modifications:

1. This program needs some additional var-
iables to keep track of the center point, the
current-corner point, and the horizontal
and vertical distances between the center
and corner points.

2. Notice that this program will draw
thicker lines than the original.

3. Starts a loop that lets you draw ovals
indefinitely.

4. Sets the pen mode for flashing interim
ovals.

5. Waits for you to select the center point by
pressing the mouse button.

Output

Figure 3
Sample output from OvalSketch.

6. Starts the loop that repeats as long as
you hold down the mouse button.

7. Assigns the coordinates of the current-
corner point to variables cornerX and
cornerY.

8. Computes the distance from center to
corner. Without the ABS function, dis-
tances are negative when the corner is
above or to the left of the center point.

9. Computes the coordinates for the cor-
ners of the rectangle in which to draw the
selected oval or circle. The top-left corner
is above and to the left of the center point,
and the bottom-right corner is below and
to the right of center.

10. Flashes the oval defined by the current
center and corner points.

11. Changes the pen mode and draws the
oval or circle in its final proportions.

12. Allows you to draw another oval. (To
halt the program, choose the Halt com-
mand or click the displayed Halt button.)
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Further Experimentation

The simplicity of these programs may
fool you into thinking that programming
an application like MacPaint wouldn't be
so tough after all. To keep things in per-
spective, try modifying SimpleSketch or
OvalSketch to do the following:

® Use thicker or thinner lines.

® Draw rectangles above or to the left
of the starting point (SimpleSketch).

® Draw circles by selecting a center
point and any point on the circumference.
The pointer must stay on the circum-
ference as you drag it away from the center.
(Hint: use the sgr function and the fact that
the length of the hypotenuse of a right tri-
angle is equal to the square root of the sum
of the squares of its sides.)



® Draw a variety of other shapes
using the QuickDraw procedures frame-
RoundRect, paintRoundRect, paint-
Oval, and paintRect in place of
JframeRect.

® Draw straight lines. Use the Quick-
Draw procedure moveTo(x,y) to anchor a
starting point and /ineTo(x,y) to draw a
line from there to another point.

® Allow freehand drawing.

® Display a palette of drawing options.
Allow the program user to use the mouse
to select the line thickness and the shape of
the object to draw.

These experiments only begin to ex-
plore the ways you can enhance the basic
SimpleSketch program. As you work out
ways to effect these improvements, new
ideas will probably come to mind. Were
you to continue adding features to the pro-
gram, you would end up with thousands of
program lines distributed among dozens of
independent procedures that would collec-
tively provide sketching and drawing capa-
bilities similar to those in MacPaint.

Macintosh Pascal

Think Technologies

Liberty Square

Danvers, MA 01923

617/777-5226

Distributed by Apple Computer, Inc.
List price: $99

Macintosh BASIC

Apple Computer, Inc.

20525 Mariani Ave.

Cupertino, CA 95014

800/538-9696; in California
800/662-9238

List price: $99

Microsoft BASIC
Microsoft Corporation
10700 Northup Way
Bellevue, WA 98004
206/828-8080

List price: $150

program OvalSketch;
var
I—EcenterH, centerY, cornerH, cornerY : integer;
Hdistance, Ydistance : integer;
left, top, right, bottom : integer;
begin
2 penSize(2,2);
3 repeat
4——  penModel(patHor);
5 —while button=false do
getMousel(centerH, center?);
6 ——while button do
begin
? getMousel(cornerH, cornery);
8 l_Hujistaam:e := abs(centerH - cornerH);
Ydistance := abs(centerY - corner?);
9 left := centeri - Hdistance;
top := centerY - Ydistance;
right := centerH + Hdistance;
bottom := centerY + Ydistance;
10 frameOval(top, left, bottom, right);
end;
ll—EpenMode(patCopgl;
frameOval(top, left, bottom, right);
i2 until false;
end.
Listing 4

OvalSketch, a MacPascal program that lets you
draw an oval by selecting the center point and
any corner of a rectangle into which it fits.
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A developer’s kit will include all the
tools you need to develop a Mac applica-
tion program on a Lisa. Among the tools
will be several complete, working sample
application programs written in Lisa Pascal
on 5%-inch Lisa disks; Mac utility pro-
grams, including a resource file editor, text
font editor, icon editor, and screen
snapshot maker, all on Mac disks; a pro-
cedure and function library for Mac
programs, on Lisa disks; and Inside Macin-
tosh, a comprehensive technical manual
containing user interface guidelines and
Toolbox procedures. Some of these items
may also be sold separately.

Apple plans to offer programming lan-
guages other than Pascal and BASIC.

Within three months of the Mac’s introduc-
tion an assembler and debugger will be
available to those programmers who prefer
coding directly in native 68000 assembly
language. Aficionados of the C language
can expect a compiler sometime within
the first six months. The C compiler will
make application program development
feasible on a single Mac.

Developer Support

Apple has two programs that support
developers. If you are actively developing
software for the Mac, you can sign up for
the Certified Developer Program. This pro-
gram entitles you to a discount on Apple
products, a subscription to a newsletter, in-
vitations to technical seminars, and more.
The Certified Developer Program itself is
free, although you must meet certain crite-
ria that establish your authenticity as a pro-
gram developer. A fee will be charged for
attending the seminars.

Certified developers can join the Reg-
istered Developer Program by paying a
nominal yearly fee. Members of this pro-
gram receive an electronic mail account
that provides a bulletin board service and
ongoing, high-level technical support from
Apple product divisions.

Apple will also offer a course con-
sisting of four or five in-depth classes to
serious developers who use the Lisa devel-
opment system. Enrollment will be re-
stricted to advanced Pascal programmers
and class size will be limited to around 20.
Within six months after the introduction of
the Mac, Apple will offer courses in Eu-
rope, Australia, and several major cities in
the United States. Schedule announce-
ments for the first course will go to regis-
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The User Interface Toolbox in-
cludes hundreds of procedures,
which have been grouped into
15 units. Some units have just a
few procedures, and others,
dozens. The grouping is purely
logical, not functional, and ex-
ists mainly to give application
programmers an organized
concept of the Toolbox. Pro-
grammers can freely choose
any combination of Toolbox
procedures from the various
units and use them in any
order. Naturally, not all com-
binations and sequences do
something useful, and a few
combinations will even crash
the system. So along with the
freedom and flexibility built
into the Toolbox goes a degree
of responsibility: programmers
must be careful to avoid those
procedural pitfalls.

Not all programming lan-
guages support every Toolbox
unit, let alone every procedure.
Lisa Pascal, in combination
with a Macintosh procedure
and function library, does sup-
port the full Toolbox. Assembly
language and C programmers
also have full access to the
Toolbox. The first release of
MacPascal, however, omits
some of the rarely used, com-
plicated, and potentially disas-
trous procedures, making the
Toolbox easier to use and pre-
cluding inadvertent system
crashes. For the same reasons,
MacBASIC and MBASIC also
limit Toolbox support.

The descriptions of the Tool-
box units that follow will give
you an idea of what an applica-
tion program can do on the

The Toolbox

Mac. The User Interface Tool-
box manual has more complete
information about the Toolbox
units and the individual pro-
cedures in them.

® Control Manager displays
buttons, check boxes, radio
buttons, scroll bars, dials, and
other application-specific con-
trols. It can also determine a
control’s setting, change the
setting, and indicate when
someone uses the mouse to
operate a control.

® CoreFEdit handles sophisti-
cated, paragraph-oriented text
editing and formatting. It sup-
ports rulers, which determine
margin justification and other
parameters.

® Desk Manager supports
the use of desk accessories
from an application. Standard
desk accessories include the
Calculator, NotePad, Scrap-
book, Clock, Key Caps, Puzzle,
and Control Panel. You can also
define your own accessories.

® Dialog Manager displays
dialog and alert boxes and re-
ceives user responses to them.

® Error Handler provides a
standard alert box for serious
system errors that the applica-
tion cannot handle.

® Event Manager reports
mouse and keyboard activity,
disk insertion, and other sys-
tem events to application pro-
grams and other Toolbox units.
It is also used for communica-
tions between Toolbox units.

® Font Manager primarily
assists the QuickDraw unit in
drawing text. Given the charac-



ters, font, style, size, scaling fac-
tor, and output device, the Font
Manager supplies the pattern
of dots that will draw the re-
quested text.

® Menu Manager displays
the menu bar. On command, it
also displays a pull-down menu
and takes the user’s order.

® QuickDraw draws straight
lines, rectangles, rounded-cor-
ner rectangles, circles, ovals,
arcs, wedges, polygons, and
arbitrary shapes, all either
hollow or solid. With a single
procedure call it can draw a
complex picture made up of
any combination of shapes and
lines.

QuickDraw, with the aid of
the Font Manager, also draws
proportionally spaced text in
any of several fonts. Characters
cdn be any of several sizes
(generally from 8 to 72 points)
and can be in any combination
of type styles including bold-
face, italic, underlined, and
outlined.

You can define multiple
drawing ports and easily switch
from one to another. Each port
has its own coordinate system,
cursor, character attributes, and
screen location. QuickDraw
provides complete image clip-
ping at the edges of a drawing
port.

You can also “draw” anything
into an off-screen memory
buffer, either for sending to
an output device or for super
high-speed display switching.
It does all of these things fast
enough to generate an interac-
tive graphic user interface,
animation, and complex text
displays.

® Resource Manager ac-
cesses information in resource
files that defines menus, fonts,
icons, dialog boxes, alert boxes,
or custom resources. Other
Toolbox procedures use the Re-
source Manager to read and
write resources. Consequently,
many application programs
never have to call the Resource
Manager directly.

® Scrap Manager helps an
application manipulate the
Clipboard for cutting and past-
ing between applications, desk
accessories, or an application
and a desk accessory.

® Segment Loader swaps
program segments between
memory and the disk, allowing
an application program to be
larger than 32K, which is the
maximum size of one segment.

® TextEdit supports basic
text editing, including word
wrap, selection, pointer move-
ment, insertion, deletion, and
replacement.

® Toolbox Utilities displays
icons and drags icons, custom
windows, or controls in re-
sponse to mouse movement.
Other utilitiés perform various
functions such as fixed-point
arithmetic, string manipulation,
and logical operations on bits.

® Window Manager creates
and manipulates windows on
the screen. It handles overlap-
ping windows and controls
window activation/deactiva-
tion, closing, sizing, dragging,
and scrolling.

tered Apple developers. Eventually, classes
will be held approximately every three
weeks at various locations around the
world.

Development languages and systems
will also be available from sources other
than Apple. Microsoft, for example, has
come up with its own development system,
centered around the C programming lan-
guage, that it uses for developing Mus/zi-
Dlan, Multichart, Multifile, Microsoft
Word, and other Microsoft applications.
Microsoft will make its development sys-
tem available to those few developers with
whom it enters into a co-development
arrangement.

Program Development

Writing application programs that
make the most of the Mac requires a thor-
ough understanding of the desktop en-
vironment; you'll have a lot to learn before
you can even create a window and print
your name in it. The user interface guide-
lines tell you what to do, and the Toolbox
gives you the capability to do it, but neither
one tells you how to do it. The trial-and-
error approach is probably the easiest way
to learn the “how-to” aspect. Start with a

AR

For now, most
serious programmers
will write Mac applica-
tions on a Lisa devel-
opment system.

working application, look at its code,
see how and why it works, and use the
same techniques to develop your own
application.

The Lisa development system lets you
do more than get ideas from working pro-
grams; you can also get working program
code from them. Cut-and-paste editing
makes this possible. You start with a work-
ing program in one window, cut out the
parts unique to the application, and leave
just the skeleton of the program. You can
open more windows for other working
programs, from which you can cut sections
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Data
Communications
for the
Macintosh

Winterhalter, Incorporated

Welcome, Macintosh!
Since 1978, Winterhalter,
Incorporated has been
providing micro-to-main-
frame communication
solutions to the Fortune
1500 community. Now,
Macintosh, it’s your turn.
Soon Winterhalter will be
offering a complete line
of data communication
capabilities for the
Macintosh. Look for more
announcements soon.

Winterhalter, Inc.

PO. Box 2180

Ann Arbor, MI 48106
800-321-7785




Open Window

Open Window

An exchange of Macintosh discoveries

Edited by Andrew Fluegelman

Open Window is a forum for
sharing discoveries about the
Macintosh. We invite and en-
courage readers to make con-
tributions to this department.
Perhaps you've come up with a
nifty routine, gained some in-
sight into how the Mac or an
application program works, or
even written a short program
that performs a useful function
or creates an interesting diver-
sion. Tell us about it and we’ll
pass your discovery along to
other members of the Mac-
world community. We’ll also
pay $25 to $100 for each Open
Window item published.

Qur first contribution to
Open Window comes from
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Macworld Contributing Editor
Lon Poole. This hands-on ap-
plication demonstrates one of
the Mac’s unique features—in-
tegrating text and graphics. Fig-
ures 1 through 6 illustrate the
steps involved in setting up a
letterhead using MacPaint and
MacWrite. See the reviews of
MacPaint and MacWrite in the
Review section for a more com-
prehensive explanation of the
features in these programs.

Send your Macintosh discov-
eries to Open Window, 555 De
Haro St., San Francisco, CA
94107, or electronically to
CompuServe 74055,412 or
The Source STE90S.
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Edit Goodies Font FontSize Style

Phyilis Tien Gallery
Phylilis Tien Gallery
‘Phyiiis Tien Gellery

218 Evaro Avenue
Gunsight, New Mexico 65302
(602) 555-4857
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Figure 1

The logo image is created using MacPaint. The gallery name is in 18-point
bold outlined New York type and filled with different patterns. The grid
option is used to keep the text aligned.
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Gunsight, New Mezxico 65302
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Figure 2
The background pattern for the logo is created by editing one of the
standard MacPaint patterns.
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